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Overview
Librarian is a companion application to BarTender that groups of designers, administrators and
other users can use to cooperatively and securely manage how BarTender documents and other
related files are stored and revised. Librarian can help you better manage any printing system, but it
is particularly valuable in highly regulated or secure environments, such as the medical,
pharmaceutical, military and chemical industries.

When you use Librarian, you store files in a centralized database rather than “loose” on various hard
drives, so files are easier to track and manage. File check-in and check-out processes prevent users
from overwriting each other's changes. You can use revision control to retain copies of all previous
versions of a file so that you not only have a history of who made what changes and when, but you
can also retrieve copies of the previous versions and even revert a file to an older version. You can
use Librarian together with Administration Console to control which users can access files in
Librarian and what those users can do with the files.

You can use Librarian to specify custom-named workflow states for files that are in different phases
of the publishing process and to create rules that govern the workflow. This makes it easy to manage
multiple levels of review before a document is published.

Developers can use the Librarian application program interface (API), which uses any .NET language,
to check files in and out of Librarian, to revert to specific revisions of a file, and to get file information
that is saved to the BarTender System Database.

Librarian is supported by the Enterprise edition of BarTender.
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File Storage and Management

Library Folder
Librarian securely stores BarTender documents and related files in its Library folder, which is a
dedicated set of tables within the BarTender System Database. By using this centralized file storage
location, you can easily organize and manage multiple files that would otherwise be loose on your
hard drive. The process for bringing files into the Library and managing them is straightforward and
uses traditional Windows file management techniques whenever possible.

Configuring the BarTender System Database

The first time that you use Librarian, you are prompted to configure the BarTender System
Database (if it is not already configured) by following the steps in the System Database Setup
wizard. The wizard configures Microsoft SQL Server or Microsoft SQL Server Express for use by
the BarTender Suite.

Implementing a Secure Database

Any person who understands databases can use SQL Server Enterprise Manager (and other
database tools) to browse and edit a SQL Server database without installing Librarian. Therefore,
when you want the highest possible level of security, your systems administrator must take
additional steps to prevent unauthorized users from accessing your SQL Server or SQL Server
Express database by using software other than Librarian.

For more information, refer to the BarTender Securitywhite paper:

https://www.bartendersoftware.com/resources/white-papers/

Folders, Files and File History
Librarian makes it easy to view the files and folder structure that you place into the Library and to
view a file's revision history.

Folders Pane

Use the Folders pane, which is located on the left side of the
Librarian window, to organize your files in any folder structure
that you want. You can add new folders, move them, and
rename them just as if they were folders in Windows Explorer.
The root directory folder, "Library," provides a basic storage
location for all of your Librarian files. This directory can be
accessed by applications in the BarTender Suite.

Files Pane

When you click a folder in the Folders pane, the files that are in that folder are displayed in the
Files pane of the main Librarian window.

The Files pane displays a timestamp and file size, just as the standard Windows Explorer file
system does, and also displays how many times a file has been revised and which publishing
workflow state each file is currently in (if states were defined).
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File History Pane

The File History pane displays a variety of revision history information that is not available in the
Windows Explorer file system. This information includes a summary of the file's most recent
transaction type, who performed that change, and which workflow state the file is in.

Managing Your Files
Adding Files to the Library

To add files to Librarian, use one of the followingmethods:

l Drag a file into the Folders or Files pane fromWindows
Explorer.

l On the Librarian File menu, click Add. Alternatively, right-
click the Folders or Files pane, and then click Add.

l When you save the file in BarTender, click the Librarian
icon in the Save As dialog, and then browse to the
Library folder in which you want to save the file.
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Getting the Latest Revision

When you get the latest revision of a file, Librarian copies the last stored copy of the file in the
database to a location on your hard drive. Librarian does not check out the file or make it
writable on your drive. You can only view the latest changes that were made to the file.

To get the latest revision of a file, select the file in the Files pane, click File, and then click Get
Latest Revision. Alternatively, right-click the file in the Files pane, and then click Get Latest
Revision. When you do this, the Get File(s) dialog opens, which you can use to browse to and
select a folder on your network into which you want to copy the selected file.

Checking In and Out

When files are stored loose on a hard drive, users can accidentally (or deliberately) open and edit
files that other users are currently working on. This creates confusion and increases the
possibility that one user might overwrite another user’s changes. Librarian solves this problem
with its check-in and check-out functionality. When a user checks out the file, the file is writable
only for that user. All other users are prevented from editing the file until the original user checks
the file back in to the library.

When a file is checked out, a red checkmark ( ) is displayed. When it is checked in, a yellow lock (
) is displayed.

You can see who has a file checked out by using the file's Properties dialog or by viewing the User
column in the File History pane. When users check out a file, their name appears next to the
Check Out action.

If you accidentally check out a file and want to check it back in without saving any changes, select
the file, and then click Undo Check Out on the File menu. Alternatively, right-click the file, and
then click Undo Check Out. Any changes that you made are discarded, and the file reverts to the
state that it was in before you checked it out.
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Deleting and Restoring Files or Folders

Any items that you delete are removed from the Library, but they can be restored to the Library
at any time. To delete an item from the Library, select the item, and then click Delete on the File
menu. Alternatively, right-click the item, and then click Delete. You can also select the item and
then press Delete on your keyboard.

To see deleted items, click Show Deleted Items on the View menu. When you do this, all
previously deleted folders and files are shown with faded file type icons.

To restore a previously deleted item, select the items that you want, and then click Undelete on
the File menu. Alternatively, right-click the item, and then click Undelete. After you do this, the
file is restored to the Library, and you can continue to manage the file as before.
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Revision Control
Any time that you save a new version of a file by using a conventional file system such as Windows
Explorer, the previous version is lost. Sometimes, however, you may want to review a list of previous
versions and possibly retrieve or revert to them. These functions are helpful for troubleshooting
revision problems and are essential for audit preparation. By using the revision control features in
Librarian, you can do the following:

l View your file history, including revision numbers, workflow state changes, the names of users
who made changes, the time and date of the revisions and any comments that were added to
the file.

l Get older file versions (when you have the correct security permissions).
l Revert to earlier file revisions.

For more information, refer to the Revision Controlwhite paper:

https://www.bartendersoftware.com/resources/white-papers/
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File States, Publishing and Workflow
Use the tools in Librarian to make your document production process work smoothly and to keep
track of a document's progress from first draft to publishing.

Workflow is the process of creating files and managing reviews and revisions until the file is deployed
or published. Because workflow management philosophy and guidelines are often unique to a
company or organization, you can use the Librarian Workflow Setup dialog to customize the
publishing process, which includes specifying the approval steps that are required and the users
who can authorize each step. This makes it easy for you to define a system of rules for creating,
reviewing and publishing files so that you can avoid the chaos of unauthorized or improvised file
deployment.

File States
By using Librarian, you can set custom workflow states for a file so that you can track it throughout
the production process. Examples of file states include "First Draft," "Editorial Review," "Project
Manager Review," "Legal Review," and so on. You can create file states that are tailored to your
publishing needs.

To configure file states, clickWorkflow Setup on the Administer menu to open the Workflow Setup
dialog.

For more information about file states, refer to the following topics in the BarTender help system:

l Workflow Setup Dialog
l Assigning States to Files
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File Publishing and Workflow
If a team strictly adheres to agreed-upon rules for how a defined system of states is used, the
document management process can be improved just by using file states. However, such a
voluntary system is vulnerable to the habits and attention to detail of the people who use it.

By using Librarian, you can gain better control over file management by defining rules for workflow
transitions as part of implementing a powerful workflow management and file publishing system.
When you do this, not only can you organize your files better, but you can also maintain more orderly
control over the revision and publishing process.

Use the Workflow Setup dialog to define a set of workflow rules to help you control your file
publishing process. After you configure the available file states, you can use the options in the
Properties for Selected State area of the dialog to create your workflow by using those states.

Specifying Allowable Initial States for a File

Any time that you add a new file to the Library or check in a new revision of an existing file, an
“initial” state must be assigned to that file in the library. You can use any file state as an initial
state, but typically, only a few of your defined file states are logical to use as this initial state.

To specify an allowable initial state for a file, click to select the Allowable initial state (for add
and check in) check box for the selected file state.

Specifying the Default Initial State

Even if you have more than one state for which the Allowable initial state (for add and check
in) option is selected, only one can be the default state. To specify the default file state that is
used in the Add File and Check In dialogs, click to select the Default initial state (for add and
check in) check box for the selected file state.

Using the Published Property

In any file development environment, you can have both published and unpublished files in your
development cycle. The workflow model that Librarian supports assumes the following about
these files:

l Unpublished files are not yet ready for use or viewing by the “general public” in an
organization. Unpublished files can be in development, waiting for approval from a
manager, or rejected as not yet suitable for publishing.

l Published files are released to the general public by the author, a manager, or an
administrator, and are viewable and usable by others.

In Librarian, a file is considered to be published if the Published property is selected in the
Workflow Setup dialog for the current state that is assigned to one or more revisions. For
example, if the "Approved" file state has its Published property selected, and if a file is in the
"Approved" state, that file is considered to be published.

You can use the Published property in Librarian together with the security settings in
Administration Console to manage file access settings. For example, users whose permissions
are limited in Administration Console to Open Published Files can open only those files whose
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current file state has the Published property assigned and are therefore published. If two or
more revisions of a file that is stored in the Library have the Published property assigned, users
whose permissions are limited to Open Published Files can open only the most recently
published revision.

The following sample scenario describes how this process might work: 

1. A file is added to the Library and is assigned an unpublished file state.
2. As part of the publishing process, a user manually assigns the file a published state. For

example, if a file state that is called “Approved” has its Published property selected in the
Workflow Setup dialog, then a file that has an "Approved" status is in a published state.

3. Another user checks out the file for the purpose of revising it.
4. When that user checks the file back in to the Library, a second revision of that file, which

has the same name, is automatically created by Librarian. An initial state, whose
Published property is not selected, is assigned to this new revision.

In this scenario, users who have different permissions specified in Administration Console have
different experiences with Librarian, as follows:

l Users who have only the Open Published Files permission can open only the first revision
of the file, because it is the only one that was published (meaning that the Published
property is selected for the file state).

l Users who have the Modify Files permission can open both the published and the more
recently revised unpublished version of the file when they open the file by using the
BarTender File menu.

For more information, refer to the BarTender System Securitywhite paper:

https://www.bartendersoftware.com/resources/white-papers/

Implementing a Workflow

To implement a true file publishing workflow, you must define the transitions between file states
that the workflow includes and allows.

For example, suppose that you create Draft, Proposed, and Approved file states. To implement a
workflow, you might specify an approval process in which files that are set to Draft must first be
set to Proposed before they can be set to Approved. 

To do this, use the Allowable Previous States and Allowable Subsequent States controls in the
Workflow Setup dialog to specify which file states can come before and after the selected file
state in your workflow. Then, when a user opens the Change State dialog to change the state of
a file, only those states that were specified as Allowable Subsequent States for the currently
active file state are listed as options in the New State list.

Importing and Exporting Workflows

You can import and export all of the settings in the Workflow Setup dialog to and from files. Note
that if you define some file states and then import a workflow, your existing list of available states
is replaced. In this case, if a named state in the current workflow is already in use by one or more
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files when a new workflow is imported, and if it is not also named in the new workflow, you are
prompted to remap the old state to one of the new states.

Security Considerations
For secure file management and revision control, you must correctly configure your system’s security
settings. This includes assigning user access rights by using the Windows security system and by
configuring the Librarian settings in the Security module in Administration Console.

For more information, refer to the Security chapter in this white paper.
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Librarian API
By using the Librarian API, you can develop custom applications, in any .NET language, that use the
primary functions of Librarian to embed revision control and workflow settings in your environment.
You can use the Librarian API to check files in and out of Librarian, revert to specific revisions of a file,
and get file information that is saved to the BarTender System Database.

Beginning a Visual Studio Project
To begin a project in Visual Studio 2005 or a later version, follow these steps:

1. On the File menu, click New, and then click Project.
2. In the Project Types panel, under either the Visual C# or the Visual Basic node, click

Windows.
3. In the Templates pane, clickWindows Application.
4. Name the project, and then click OK.
5. After you create the project, add a reference to Seagull.BarTender.Print.
6. In the Solution Explorer pane, right-click the References node, and then click Add Reference.
7. In the Add Reference window, click the .NET tab, select Seagull.BarTender.Print, and then

click OK.
8. Verify that the project can build and compile by pressing Ctrl+Shift+B on your keyboard. If

this operation is successful, you are ready to begin your project.

Using the Librarian API
Adding Files to the Library

When you add a file to Librarian, users on the network can access the file from the BarTender
System Database. Subsequent changes to the file are also recorded to the system database,
which means that users can revert to or track previous changes.

You add a BarTender file to the Library by calling the Library class AddFile method. The following
C# code is an example of how to add a file to Librarian.

Library library = new Library();
LibrarianFile file = library.AddFile("lib://Formats/Address.btw",
@"C:\Users\Administrator\Documents\Address.btw", "Added Address.btw to the
library.");

The first parameter that is passed in the AddFile method is the file name and the path of the
folder where you want to save your document. The second parameter specifies the path and file
name of the file to add, and the third parameter is the comment that describes the addition of
the file into the Library.

The Library class provides an overload for the AddFile method to specify additional advanced
options for adding a file.
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Checking In Files

You can check a file in to the Library by using the LibrarianFile CheckIn method, which retrieves a
file from a specified location on your computer and saves it to a folder in the Library.

Several overloads exist for the CheckIn method. The simplest overload requires the path and file
name of the file on your computer and a comment that describes the changes that were made
to the file. The following C# code is an example of how to check in a file to the Formats directory
of the Library.

Library library = new Library();
LibrarianFile file = library.GetFile("lib://Formats/Address.btw");
int revisionNumber = file.CheckIn
(@"C:\Users\Administrator\Documents\Address.btw", "Modified the label design.");

The first parameter in the CheckIn method specifies where to retrieve the file on your computer.
The second parameter specifies a comment that describes the changes that were made to the
file while it was checked out. Additional parameters can specify advanced check-in options.

Checking Out Files from the Library

You can check out a file from the Library by using the LibrarianFile CheckOut method, which
saves the file to a specified location on your computer and makes the file available for editing.

Several overloads exist for the CheckOut method. The simplest overload requires only the path
and file name of the location where you want to save the file. The following C# code is an example
of how to check out a file from the Library.

Library library = new Library();
LibrarianFile file = library.GetFile("lib://Formats/Address.btw");
file.CheckOut(@"C:\Users\Administrator\AppData\Local\Temp\Address.btw");

The first parameter in the CheckOut method specifies where to save the file. Additional
parameters can specify advanced check-out options.

Displaying Folder Contents

In Librarian, files and folders are stored in folders that consist of a single root directory and its
subdirectories. The root directory is the Library folder. This directory can contain subdirectories
that you create, such as "Templates" or "Images." Each subdirectory can contain any number of
subdirectories.

You can list the contents of a directory in Librarian by using the LibrarianFile Name and/or Path
properties together with an iteration statement, such as a For loop. The following C# code is an
example of how to display a list of files in a directory that is stored in Librarian.

Library library = new Library();
LibrarianFolder folder = library.GetFolder("lib://Templates");

// Iterate through the subfolders
StringBuilder listingBuilder = new StringBuilder();
foreach (LibrarianFolder subfolder in folder.Folders)
   listingBuilder.AppendFormat("Folder\t{0}\t{1}\tChildren: {2}\n",
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subfolder.Name, subfolder.Path, subfolder.Children.Count);

// Iterate through the files in the directory
foreach (LibrarianFile file in folder.Files)
   listingBuilder.AppendFormat("File\t{0}\t{1}\tRevision: {2}\n", file.Name,
file.Path, file.RevisionNumber);

// Display the contents of the folder
System.Windows.Forms.MessageBox.Show(listingBuilder.ToString(), string.Format
("Folder Contents ({0})", folder.Path));

In this example, a list of subdirectories and files is saved to a list of strings that is called
listingBuilder. After the list is populated with the contents of a directory, the name, path, and/or
revision number of each subdirectory or file is displayed in a message box.

For more information, refer to the Librarian API section in the Automation with the BarTender
.NET SDK book of the BarTender help system.
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Security
To implement a secure printing system, you must ensure that the user permissions that are
specified in Administration Console allow only authorized users to access Librarian and BarTender.

Librarian Permissions in Administration Console
In Administration Console, two groups of permissions settings apply to Librarian: Librarian and
Librarian: File States.
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Librarian Permissions

You can configure the following permissions in the Librarian section of Administration Console:

l Run: Allows users to run the Librarian application. Users who have only the Run
permission can view files and file history information.

l Administer: Allows users to use the Librarian Administer menu to access the System
Setup and Workflow Setup dialogs and to modify their settings.

This permission should be granted only to users who
require the highest level of administrative control within
Librarian.

l Edit Existing Comments: Allows users to edit existing comments that were logged when
someone checked a file in, renamed a file or performed some other action on it.

l Edit Files: Allows users to perform the following actions:

o Add comments to a file
o Add files to the library
o Check in files
o Check out files
o Revert files to previous revisions
o Open files that are stored in the Library

l Full File Control: Allows users to perform all the Edit Files actions and also move,
rename, delete and restore files in the Library.

l Open Published Files: Allows users to open files that are in a Published state.

Librarian: File States Permissions

You can use this section to configure user permissions to allow users to assign or change some
or all of the file state for files in a workflow. This is especially useful when you want to limit the
number of users who are authorized to change files to a Published state.

The files states that are listed correspond to the file states that are configured in the Workflow
Setup dialog.

For more information about file states, refer to the File States, Publishing and Workflow section
of this white paper.

BarTender Permissions in Administration Console that Apply to Librarian
The BarTender permissions section of Administration Console includes the following permissions
that apply to Librarian:
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l Print Published Documents: Allows users to print the latest published revision of a document
that is stored in the Library. When you authorize a user to print documents, you also grant
permission to print published documents.

Because a file can be assigned a state only if it is kept in the
Library, files that are stored loose on a hard drive rather than in
the Library can never be assigned a Published state.
Therefore, when you deny BarTender users the Print Published
Documents permission, you prevent them from even opening
documents from their individual hard drives. This can prevent
users from loading, creating and printing unauthorized
documents.

l Print Unpublished Documents: Allows a BarTender user to print unpublished documents that
are stored in the Library and all documents that are stored loose on a computer or the
network. The Print Unpublished Documents permission includes permission to Print
Published Documents.

Users who are denied this permission can only open
documents that are both stored in the Library and in a
Published state.

For more information about the Published property, refer to the File States, Publishing and Workflow
section of this white paper.

Organizing Users and Groups According to Their Functional Roles
When you plan the Librarian file states and Administration Console permissions that your file
management system will use, we recommend that you sort users into their functional roles and then
configure their permissions accordingly. For example, you might sort users into File Designers, File
Editors, Print Operators, and Publishers groups and then grant different types of permissions to each
group.

When your organization has multiple users who perform similar functional roles, it is easier to
organize them into domain user groups so that you can manage all of the group’s permissions at one
time instead of separately defining permission settings for each individual user.

Advanced Security
More advanced techniques that you can use to create and implement a secure file publishing
workflow within Librarian include the following.
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Electronic Signatures

To improve the security in your publishing system, you can use Administration Console to specify
that users must enter an electronic signature (user credentials) when they change a file’s state.
You specify this requirement in the Librarian: File States section of the Electronic Signatures
page in Administration Console.

Logging

By using the Administration Console Logging page, you can specify that any or all user requests
to perform actions that are listed in the Librarian section and the Librarian: File States section
are logged to the BarTender System Database. Then, you can review which users have
requested to perform which actions.

Document Encryption

By using the Administration Console Document Encryption page, you can encrypt individual
BarTender documents. Note that encryption is an advanced security technique that has certain
risks that you must guard against. For more information, refer to the Document Encryption Page
topic in the BarTender help system.

Controlling the Printing of Unpublished Documents

A security risk occurs any time that a user prints an unpublished (and therefore unauthorized)
BarTender document. Therefore, you should grant the Print Unpublished Documents
permission only on an as-needed basis.

Also, to guard against the possibility that unauthorized users might use someone else's
computer to print unpublished BarTender documents, you may want to require that users enter
electronic signatures before they can print. When you do this, you also create a log of the
authorized users who printed unpublished documents and when the print jobs occurred.
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Appendix A: Integrating Librarian with BarTender and Companion
Applications
You can use files that are stored in Librarian in many of the companion applications that are included
in the BarTender Suite. This appendix describes how each application can work with Librarian in your
production environment.

Administration Console
Use the Administration Console Librarian and Librarian: File States permissions to control whether
users can do the following:

l Edit existing comments in a document that is stored in Librarian
l Edit files that are stored in Librarian
l Have full file control over files that are stored in Librarian
l Open published files that are stored in Librarian
l Change file states

For more information, refer to the Security section of this white paper.

BarTender
When you work in a BarTender document, you can use BarTender Designer to access related files,
such as databases or images, that are stored in Librarian.

Integration Builder
Integrations can be saved to and opened from the Library, and Integration Builder can refer to files
that are stored in the Library.

Librarian Syntax and Integration Builder

The referencing syntax that Librarian uses can be used in Integration Builder to refer to a file
from a command prompt. Integration Builder can use Librarian syntax with BarTender XML
(BTXML) script, which is used when you run commands from within Integration Builder that start
and control BarTender print jobs.

For more information about Librarian syntax, refer to Appendix B: Syntax for Referencing Files in
the Library.

Librarian 20



Print Station
You can select a Librarian folder to be the root folder for Print Station. This is the folder that Print
Station uses to display the documents that are available to be printed.

Process Builder
You can save BarTender process files, which have the *.btproc file name extension, in the Library
and edit them by using Process Builder. Additionally, process files can refer to BarTender documents
that are stored in the Library.

Reprint Console and History Explorer
Reprint Console and History Explorer interact with Librarian indirectly via BarTender. BarTender
documents that you view and/or reprint by using these applications can reside in the Librarian
database.

For more information about the companion applications, refer to their corresponding white papers:

https://www.bartendersoftware.com/resources/white-papers/
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Appendix B: Syntax for Referencing Files in the Library
Librarian provides a syntax for referencing files in the Library, similar to the standard syntax for
referencing files on a hard drive.

Review of Standard Windows Syntax
Because Windows users typically use their mouse to click through folders and subfolders to find files,
they may not remember that the file path syntax that Windows uses is the following.

C:\<path>\<filename>

For example, to open a BarTender document, you might reference it by using the following syntax.

C:\MyTemplates\ShippingLabel.btw

Referencing Files in the Library
The syntax for referencing files in the Library more closely resembles an Internet location than a hard
drive location. The syntax is as follows.

lib://<path>/<filename>

This Internet-style URL uses forward slash marks instead of backslashes, and the “lib://” at the
beginning is always required to reference files in the Library. Therefore, when you access a file in the
Library, you use the following file reference syntax.

lib://MyTemplates/ShippingLabel.btw

Library files can be referenced by using one of the followingmethods:

l On the BarTender or Librarian File menu, click Open, and then enter the text string for the file
that you want to reference in the File Name field.

l In Process Builder, click the Administration tab, click Open, and then enter the text string for
the process file that you want to reference in the File Name field.

l In Print Station, enter the text string for the file that you want to print in the Search field.
l Run BarTender by using command-line parameters. The following sample command instructs
BarTender to open a document from the Library and then start a print job.

bartender.exe /F="lib://templates/shipping/overnight.btw" /P

l Run a print job that requires BarTender to read data-sourced graphics while printing.
l Run a BarTender XML script.
l In Integration Builder, run commands that start and control BarTender print jobs.

For more information about how Librarian interacts with BarTender and the companion applications,
see Appendix A: Integrating Librarian with BarTender and Companion Applications.
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Related Documentation

White Papers
l BarTender System Security
l Revision Control
l Administration Console

To view and download white papers, visit:

https://www.bartendersoftware.com/resources/white-papers/

Manuals
l Getting Started with BarTender

https://support.seagullscientific.com/hc/categories/200267887

BarTender Help System
l Librarian

Other Resources
Please visit the BarTender website at https://www.bartendersoftware.com.
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